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STARTING GUIDE 
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 Starting Guide (for Beginners) 

 

In this guide, we will quickly cover all the basic steps in order to have an operative 
car, all of which will be covered with more detail during the entirety of this 

document. 

 

  Figure 1: Set up instructions 

First off, the chassis of the car 
will need to be assembled. The 
tutor will provide a chassis but 
the teams can choose to design 
and print their own chassis; 
more details on how to 
approach this will be discussed 
in documents Introduction to 
Freecad and 3D Printing. 

All components needed for the 
assembly of the car are included 
in the bag provided by the tutor, 
with a guide (in Mandarin 
though) on how to assemble 
them properly; this is explained 
in detail in document Inventory. 

Once this is done, the next step 
will be to connect the car and 
the Raspberry PI/Gertbot duo 
that will control it. 

Two batteries will be needed 
(each one powers two wheels) 
and a power supply to power 
the Raspberry PI and Gertbot. 

Introduction to Gertbot explains 
in detail how to connect the 
Gertbot to the four wheels. 
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In order for the Gertbot to work properly, the Raspberry PI will have to be 
operational. To do this, a SD card is needed. 

Format the SD card and then install an Operating System in the Raspberry PI, this 
is explained in detail in Introduction to Raspberry PI. 

As working with the Raspberry PI can be a bit uncomfortable, Remote Connection 
to Raspberry PI explains how to remotely connect to the PI; which will make 
programming and testing code much easier. 

If you are using a Raspberry PI 3, you might need to activate the UART to get the 
Gertbot to work (supposedly you don’t, but when we tried it, it turned out that you 
did). This is explained at the end of documents Introduction to Raspberry PI. 

Introduction to Gertbot explains how to set up the Gertbot and try out the DC 
motors (the same ones that will make your wheels spin). 

Once all is correctly set and ready to go, the Gertbot will need instructions 
regarding what it is that we want it to do. To do this, a Python script will be 
needed. 

The official Gertbot website has a Python source code for two brushed motor 
vehicle on/off control which can be the foundation for a functional script for this 
prototype. Programming includes an example of fully operative code for four 
motors, including reverse, two different speeds going forwards and the ability to 
turn right and left. 

Attached is the Flow Chart on how to set a functional prototype from scratch. 
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1. General Requirements 

 
1.1 Circuit Dimensions 
 

The circuit used in the competition is shown in the figure below (Figure 1) 

 
Figure 1: Top view of the race area including trajectories 1 and 2 

 

The field will have the following minimum measurement: 

The field must be at least 5 metres long, and 5 metres wide. 

There will be two different tracks, each one with their unique measurements: 

Trajectory 1: A straight line between two points; A and B. Both points will be 3 
metres apart.   

Points will be placed one metre away from the edge of the circuit. 

Both speed between points A and B and accuracy to stop exactly in the ending 
points are considered in the evaluation.  
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Trajectory 2: An infinity loop figure around two points; C and D. Both points will 
be 3 metres apart.   

Points will be placed one metre away from the edge of the circuit. 

The centre of the infinity loop will be a metre away from the edge of the circuit.  

Both speed (both forward and steering) and adaptability to the trajectory are 
considered in the evaluation.  

 

2. Requirements for the vehicles 

 
 

2.1 General Robot Specifications 
 

The vehicle must be able to be placed inside a cube of 22 centimetres in length, 17 
centimetres in width and 22 centimetres in height.  

The vehicle will weigh less than 2 kilogrammes. 

The propulsion system must be electrical. 

All the necessary components needed to build the vehicle will be provided by the 
tutor.  

The following list of components is an example of the type of materials that will be 
available to complete this task: 

- Raspberry pi computer board. 

- Small DC motors. 

- IC drivers. 

- Cables. 

- Power Bank (5 V). 

The tutor will provide each team with a chassis; however teams will have the right 
to design their own chassis using a 3D CAD software. Students are encouraged to 
use Open source applications such as FreeCAD (http://www.freecadweb.org/).  

Once the chassis has been designed and approved by the tutor, the students will be 
allowed to synthesise it with a 3D printer.  

A Witbox 3D printer (http://www.bq.com/gb/witbox) will be available. The 
printer file can be generated with the Open Source software Cura 
(https://ultimaker.com/en/products/cura-software). 

http://www.freecadweb.org/
https://ultimaker.com/en/products/cura-software
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2.2 Class Specifications 
 

The vehicle can be autonomous or it can be manually controlled by the student. 
Any control mechanisms can be employed.  

Computational power can be either on board or on an external computer, which 
will communicate wirelessly with the robot. Additional navigational aids can also 
be used; these can include a dashed-line on the floor, active or passive navigational 
aids inside the race area, or additional guides.  

Active navigational aids (e.g. infrared beacons) must run on battery; there will be 
no power outlets available. 

Setup of navigational aids must take place within the established preparation time. 
Navigational aids shall be removed residue-free within two minutes after the race 
time.  

 

2.3 Security and Safety 
 

Failure to comply with the security and safety rules will lead to disqualification of 
the team. 

Equipment and operations must comply with Spanish law. 

Only electric propulsion vehicles are allowed to participate in the competition. The 
vehicle must always be clearly identified with the starting number obtained during 
its registration.  

Vehicles may not have sharp or potentially dangerous parts. A human safety pilot 
must be able to take over control of the vehicle at any time in case of an 
emergency.  

Entrance to the race area is only permitted for one team member of the scheduled 
team after clearance by the judge.  

Teams must always follow the instructions of the judge. The judge can abort the 
race at any time should it be necessary. 

 

2.4 Certification 
 

In order to compete, all vehicles must first be certified by the judges. This check 
will be performed before the first race and covers all points listed below. 

1. The robot must show its ability to adapt to the race track. 
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2. The ability to safely control the vehicle has to be shown by the team member 
who will operate the robot (robot operator) during the competition. 

3. The vehicle must comply with all security and safety requirements. 

 

3. Game 

 

 

3.1 Aim of the Game 
 

The vehicle has to complete both tracks within a specified time frame of 10 
minutes. 

 

3.2 Start of the Game 
 

Each team is allocated a preparation time slot of up to 5 minutes. During the 
preparation time, one team member (robot operator) is allowed to enter the race 
area in order to prepare for the start of the game. When preparation is complete or 
the preparation time is over, the judge will signal the start of the 10-minute race 
time and the robot operator can start the robot.  

The start has to be performed at the starting line, which will be indicated by the 
judges. 

During the race the robot operator must leave the race area for safety reasons. 

 

3.3 Restart 
 

A race ends when the robot touches the external perimeter or the robot operator 
decides to abort the race.  

Multiple starts are allowed during the moving time.  

The robot operator may reenter the race area after the judge clearance and restart 
the robot.  

During the race the robot operator must leave the race area for safety reasons. 
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3.4 End of the Game 
 

The race finishes when the 10-minute mark is reached or when the judge aborts 
the race. 

 

3.5 Scoring System 
 

1. The vehicle has to move from point A to point B according to figure 1. 
Completing this for the first time will be awarded with 10 points. 

2. The robot has to move around the two poles (C and D) in the way shown in 
figure 1.  Completing this for the first time will be awarded with 20 points. 

3. Each additional lap to each trajectory (A to B or C and D) will be awarded with 
one point. 

4. The lightest robot will be awarded with 5 points. 

 

3.6 Declaring Objections 
 

No objections shall be made against the decisions of the judges after the end of the 
competition.  

All teams must choose a spokesperson who will present objections to the judge, 
always before the competition is over, if there are any doubts regarding the 
implementation of these rules.  

 

3.7 Flexibility of Rules 
 

As long as the concept and fundamentals of the rules are observed, these rules 
shall be flexible enough to encompass the changes in the number of players and of 
the contents of the matches.  

Modifications or abolition of the rules may be made by the local event organisers 
as long as they are published prior to the event, and are consistently maintained 
throughout the event. 

 

3.8 Liability 
 

Participating teams are always responsible for the safety of their robots and are 
liable for any accidents caused by their team members or their robots.  
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The SEVC organisation and the organising team members will never be held 
responsible nor liable for any incidents or accidents caused by participating teams 
or their equipment. 
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1. Assembling the vehicle 

 

1.1 Inventory 
 

In order to assemble our vehicle, a number of parts will be given to the student. 

This is the assembly guide that will be presented to the student. 
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Figure 1: Components of the chassis 

As can be seen, the instructions are in Mandarin; so this will be a tutorial on how to 
put the vehicle together. 

 

1.2 The pieces 
 

The following pieces will be needed to assemble the car. 

First, the smaller parts: 

 

Figure 2: Detailed parts 

 

In order to make the explanation easier, each part has been given a letter. 
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The number of parts needed is specified in the image above, they are: 

- 6x Part A 
- 14x Part B 
- 8x Part C 
- 10x Part D 
- 8x Part E 
- 4x Part F 

Besides these smaller parts, we will also need the following:  

 

 

Figure 3: Wheels, motors and covers 

 

- A case for our power source. 
- Four wheels 
- Four motors 
- Inferior chassis 
- Superior chassis 

With all of these items listed and ready, the set-up is quite easy. 

 

1.3 How to do it 
 

First off, we place the E parts on the chassis, as seen in the image below: 
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Figure 4: Step 1 

 

Once that is done, we will proceed to place the motors. 

 

Figure 5: Step 2 

 

Two screws (B part) will be needed, they will be secured with their respective cog 
(D part). 
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Then, place the wheel as below: 

 

Figure 6: Step 3 

 

Then, the process has to be repeated for the other three wheels, which will end up 
like the below picture: 

 

Figure 7: Step 4 
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To attach the upper chassis, screw pieces A and B together through the holes as 
shown in the below image: 

 

Figure 8: Step 5 

 

Then place the upper chassis and secure with some cogs. 

 

Figure 9: Step 6 

 

Once this has been done, we will then connect the four motors to the Gertbot. 
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1. What is the Raspberry Pi? 

 

Raspberry Pi is a low-cost, basic computer that was originally intended to help 
spur interest in computing among school-aged children. The Raspberry Pi is 
contained on a single circuit board and features ports for: 

• HDMI 
• USB 2.0 
• Composite video 
• Analog audio 
• Power 
• Internet 
• SD Card 

The computer runs entirely on open-source software and gives students the ability 
to mix and match software according to the work they wish to do. 

The Raspberry Pi debuted in February 2012. The group behind the computer's 
development - the Raspberry Pi Foundation - started the project to make 
computing fun for students, while also creating interest in how computers work at 
a basic level.  

Unlike using an encased computer from a manufacturer, the Raspberry Pi shows 
the essential guts behind the plastic. Even the software, by virtue of being open-
source, offers an opportunity for students to explore the underlying code - if they 
wish. 
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The Raspberry Pi is believed to be an ideal learning tool, in that it is cheap to make, 
easy to replace and needs only a keyboard and a TV to run. These same strengths 
also make it an ideal product to jumpstart computing in the developing world. 

2. Setting up the Raspberry PI 

 

Figure 1: Raspberry PI 

 
The following will also be needed: 

• One SD card 
• An SD card reader so the OS image can be written onto the SD card 
• A means of supplying power to the unit. At the very least, a 5v micro-USB 

adapter will be needed. 
• An HDMI cable and HDMI-to-DVI converter if a monitor is being used 

instead of a high-definition television. 
• A USB mouse and keyboard 
• An Ethernet cable 

 

2.1 Formatting the SD Card 
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Before installing any operating system in the SD card, it is best to erase all that it 
might contain as this will mean a smooth installation of the new operating system. 

For this purpose, we will use SDFormatter to restore full capacity to the SD card. 

The software is available for free on the SD Association website. Once this is 
downloaded the process is very simple: 

1. Run the SD Formatter Application. 
 

2. By default the Format Size Adjustment option is off.  
 
 

 

Figure 2: Format Options 

 
 

3. Click Options and turn the Format Size Adjustment on. 
 
 

 

 Figure 3: Format Size  
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4. Select the drive letter for the SD card and then select format. 
 

 

Figure 4: Quick Format 

 

Now the SD card is ready for installation. 

 

2.2 Installing an Operating System in the Raspberry PI 
 

For this tutorial, we have opted for NOOBS (New Out Of Box Software) as the 
operating system install manager that will install Raspbian in our Raspberry PI. 
NOOBS also provides a selection of alternative operating systems which are then 
downloaded from the internet and installed. 

NOOBS is very easy to obtain, it is available for download on the Raspberry PI 
official website, and is not very large in size (around 4GB, although a SD card with 
a minimum capacity of 8 GB is recommended) which will make most SD cards valid 
for this installation process. 

Once the SD card has been formatted and all NOOBS files have been downloaded, 
drag all the files in the extracted folder and drop them onto the SD card drive. 
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Figure 5: NOOBS Files 

 

When this process has finished, safely remove the SD card and insert it into your 
Raspberry Pi. Connect your Raspberry PI to a monitor and then to a power cable. 

The Raspberry PI will then boot and a window will appear with a list of different 
operating systems that you can install. Select Raspbian and click on Install. 

 

 

Figure 5: Selecting Raspbian 
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Raspbian will then run through its installation process. Note that this can take a 
while. 

 

Figure 6: Raspberrry PI’s Desktop 

 

When the install process is complete, the Raspberry Pi configuration menu (raspi-
config) will load. Here you are able to set the time and date for your region, enable 
a Raspberry Pi camera board, or even create users. You can exit this menu by using 
Tab on your keyboard to move to Finish. 

The default login for Raspbian is username pi with the password being raspberry. 
This will be needed when you connect remotely to the Raspberry. 

 

2.3 Updating and upgrading Raspbian 
 

As we keep using the Raspberry PI, updates of the software will be released over 
time; and it will be in our best interest to upgrade our system with these updates. 

To do this, start by updating your system's package list by entering the following 
command in LXTerminal or from the command line:  

sudo apt-get update 

 

After that, upgrade all your installed packages to their latest versions with the 
command: 

sudo apt-get dist-upgrade 
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Doing this regularly will keep your installation up to date. However, there are 
occasional changes made in the Foundation's Raspbian image that require manual 
intervention, for example a newly introduced package. These are not installed with 
an upgrade, as this command only updates the packages you already have 
installed. 

When running sudo apt-get dist-upgrade, it will show how much data will be 
downloaded and how much space it will take up on the SD card.  

It's worth checking with the command df -h that you have enough disk space free, 
as unfortunately the command apt will not do this for you. Be aware that 
downloaded package files (.deb files) are kept in /var/cache/apt/archives. You can 
remove these in order to free up space with the command sudo apt-get clean. 

 

2.4  Activating UART 
 

In order to control our car, we will use the Raspberry PI and a motor/power 
controller board for the PI called Gertbot. 

To use the Gertbot, we first have to activate the UART interface for the Raspberry 
PI; even though this step is supposedly not needed work with Raspberry PI 3, we 
had to activate it manually. 

To do this, type the following commands in the command prompt: 

sudo raspi-config 

Then, disable the serial console. From the main menu, select option 7 (Serial), then 
select 'No' to disable shell and kernel messages via UART. 

Now, enable UART. First, edit config.txt by typing the following command in the 
command prompt: 

sudo nano /boot/config.txt 

And remove the line:  enable_uart=0 if it exists. And add at the end of the file the 
following line: 

enable_uart=1 

Save the file and reboot the Raspberry PI, freeing UART in the process. 
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REMOTE CONNECTION TO RASPBERRY PI 
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1. Connecting remotely to the Raspberry PI 

 
Setting up the Raspberry for remote access is something very helpful. There won’t 
always be an extra screen and keyboard available nor even a local network to 
connect. There is also the chance that you may not even have physical access to it.  

The following steps will provide with a solution to this by explaining how to set up 
a SSH connection and a remotely connect to the Raspberry without the need of 
screens or a keyboard or even a power supply. 

First, access the network adapter configuration on your computer by right clicking 
on the connection icon in the system tray and selecting Open Network and Sharing 
Centre.  

Follow Figure 1 and Figure 2 to reach it.  

In case a power supply is not available; you can also power the Raspberry through 
a USB port from the computer. USB 3.0 is recommended as 2.0 may not be 
sufficient to power the Raspberry.  

Connect the Raspberry to the Ethernet connector of your computer.  

 

 

Figure 1: Open Network and Sharing Centre 
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Figure 2: Change adapter settings 

 

Now, we need to create a bridge connection Next step is creating a bridge 
connection between the Wi-Fi connection and the Ethernet adapters as shown in 
Figure 3. 

 

 
Figure 3: Bridge Connections 
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Once the bridge is ready (it might take a couple of minutes) disconnect the Wi-Fi 
adapter from the bridge. To do this, right click on the Wi-Fi adapter and click on 
Remove from bridge.  

Then, right click on the Wi-Fi adapter enable the shared Internet connection within 
the Properties menu. 

 

Figure 4: Internet Connection Sharing 

 

Now that all this has been done, the Raspberry will have an IP address similar to 
the template 192.168.137.XXXX. We are missing the last part of that address, so we 
need to obtain it. 

Download and install Network Scanner which is available at the SoftPerfect 
website. 

After installation is complete enter the complete IP range for the search (the 
address we had can only go from 0 to 255) and click the Start Scanning icon. 
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Figure 5: Searching for the IP 

 

Now that we know the Raspberry’s IP, SSH connection is possible. Every time the 
Raspberry is rebooted, this search will need to be repeated.  

If working within a LAN, setting a fixed IP can be an option. Searching ifconfig can 
help with this matter. 

The SSH connection is activated by default on Raspbian so everything is ready to 
execute putty.exe; available at the Putty website. 

Set the right IP and click open. Disregard the security warning if it appears. Once 
the password is accepted, full access to the Raspberry will be granted although GUI 
interface is not available. Internet connection will be shared with the Raspberry. 

 

 

Figure 6: Accessing the Raspberry PI 

If GUI interface is required, the following steep will need to be followed in the exact 
same order. 

First thing to install is tightvnc server which requires an Internet connection: 

sudo apt-get install tightvncserver 
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We will be connecting using Windows Terminal Server (also known as Remote 
Desktop) as it is available in all Windows OS.  

For this to work, xrdp software is required, which also requires an Internet 
connection: 

sudo apt-get install xrdp 

After the installation, start the service: 

sudo /etc/init.d/xrdp restart 

Remote connection with GUI will now be available. Note that this creates a new 
session on the Raspberry. 

 

 

Figure 7: Remote Desktop Connection 

 

 

Figure 8: Raspberry PI’s Desktop 
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1. The Gertbot 

 
 
1.1 What is a Gertbot? 
 

The Gertbot is a motor/power controller board for the Raspberry-Pi. The strength 
of the board is that it has its own CPU which frees up the Raspberry-Pi from a lot of 
intense computations and will take care of all the real-time requirements.  

All the user will have to do is give it high level commands. For example: Board 2, 
Motor 1, take 2432 steps at 67 Hz.  But even that is taken care of by using the 
Gertbot Debug GUI which is available on the Gertbot website. 

 

1.2 Getting started with the Gertbot 
 

In order to have our Gertbot up and running as quickly as possible, these steps are 
a good guide to follow: 

1. Connect a DC-brushed motor or stepper motor to the Gertbot. In our case, one 
of the four motors of our car.  
 

2. Those motors will need a power supply that must be connected to the Gertbot. 
The controller need a minimum of 8 volts in order to work, for safe operation 
do not connect more than 18 volts.  
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In order to connect motors and power supplies use the following diagram: 

 

 

Figure 1: Gertbot connections 

 

The Gertbot can manage up to four motors, and needs two power sources for this. 

 
3. Plug the Gertbot board on top of a Raspberry-Pi board which must be powered 

down. Then boot the device. 
 

4. As explained earlier, you can remotely connect to the Raspberry PI. This guide 
will continue explaining as if the student is using this method. 

 
5. Login to the Gertbot website and download the Gertbot Debug GUI executable. 

(You might want to make a directory to put all the Gertbot data into). Extract 
the executable and run it. 
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6. Press the Connect button. A log window will pop-up and show the search for 

boards. Default from the factory the board has ID 3 so you should see this: 
 

 

Figure 2: Gertbot GUI 

 

 

Figure 3: Searching for boards 

 

7. Use the control under “Motor 0” to select the operating mode. In this guide, we 
are using DC/brushed motors.  

 



4 
 

Figure 4: Testing the motors 

 

 

 

As can be seen, we can alter the frequency and its duty cycle to adjust it to 
our needs.  

You can now play with the buttons and your motor should run. 
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1. Programming the car 

 
 
1.1 Driving the car 
 

Now that the Raspberry PI is connected and the car is ready to go, there is only one 
step missing: driving the car.  

To do this we are going to use the Gertbot, which should be connected as explained 
before, to drive our motors as we command it to. In order to communicate with the 
Gertbot, we will use Python as our language. 

The official Gertbot website has a Simple Rover example we can download, which 
is a Python source code for two brushed motor vehicle on/off control that can then 
be modified to meet our requirements. 

 

 

 

 

 

 

 

 
 

 



2 
 

 

 
1.2 Programming 
 

Using the Simple Rover example as a template, it is quite easy to add the lines that 
we need to transform this example to a fully functioning 4 wheeled remote 
controlled car.  

There are several ways to write a script that can achieve this. Attached is one of 
them:  

 

Figure 1: Development Environment 

 

The Board ID of the Gertbot is 3, so that is the first thing to change in our code. As 
we want to have four wheels, we will have to add two of them to our code (see 
above Right1, Right2, Left1 and Left2). 

In the event that different speeds are required, different duty cycles will have to be 
declared (duty and duty1 in this example), as well as the frequency that will be 
used. 
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Figure 2: Setting channels 

 

This is the main program setup for our two new wheels will have to be added (as 
seen above). 

The following attached figures will set up how the car can be driven and the speed 
that it will have depending on the action being performed. 

As there are nine keys in the numeric keypad, there are nine actions that our car 
will perform; which in this example are: 

- By pressing number 1: Both left side wheels will rotate backwards at 
normal speed. 

- By pressing number 2: All wheels will rotate backwards at normal speed. 
- By pressing number 3: Both right side wheels will rotate backwards at 

normal speed. 
- By pressing number 4: Both left side wheels will rotate forwards at normal 

speed. 
- By pressing number 5: All wheels moving will stop. 
- By pressing number 6: Both right side wheels will rotate forwards at 

normal speed. 



4 
 

- By pressing number 7: Both left side wheels will rotate forwards at top 
speed. 

- By pressing number 8: All wheels will rotate forwards at top speed. 
- By pressing number 9: Both left side wheels will rotate forwards at top 

speed. 

Below is the script that allows this: 

 

Figure 3: Driving the car 
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Figure 4: Driving the car 
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1. Creating an Ad Hoc WiFi Hotspot 

 

 

1.1 Why do we need this? 
 

It would be rather difficult to drive our car if it were connected through wires to 
our computer. To solve this, an Ad Hoc Hotspot can be created so we can wirelessly 
connect our Raspberry PI. 

All that is needed is our Windows 10 machine and an Ethernet connection. 

 

1.2 Setting it up in Windows 10 
 

To start, right click on Start button or press the Windows + X keys to open the 
power user settings panel, and launch Command Prompt (Admin). 
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Figure 1: Command Prompt 

Enter the following command and hit the Enter key at the end. Name your Ad hoc 
connection with a name of your choice and change the password to one of your 
choice: 

netsh wlan set hostednetwork mode=allow ssid=mynetwork key=password 

 

Figure 2: Creating the network 

 

Enter the following command and hit the Enter key:  

netsh wlan start hostednetwork 

 

Figure 3: Starting the network 

Open the “Network and Sharing Centre” window, then click on “Change adapter 
settings” which can be found in the Control Panel. 
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Figure 4: Network and Internet 

Right-click your Ethernet connection and select Properties and switch to the 
Sharing tab. 

 

Figure 5: Ethernet Properties 

Check the “Allow other network users to connect through this computer’s Internet 
connection” option, and choose the newly created WiFi connection from the drop 
down list located under “Home networking connection”. 
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Figure 6: Sharing tab 

The Hotspot is now up and running, you can connect your Raspberry PI to it in 
order to access it remotely and drive your car without any issues. 

 

Figure 7: Networks 
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If you wish to disable the hotspot at any given time, simply enter the following 
command in Command Prompt with Administrator privileges and hit Enter: 

netsh wlan stop hostednetwork 

 

 

Figure 8: Stopping the network 
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1.1 Download FreeCAD 

FreeCAD is a free programme. It can be downloaded from their 
website https://www.freecadweb.org/ for free. Once it is downloaded, proceed to 
install it. 

 
1.2 Setting the correct units 

Before starting a project, you must decide which units are going to used. The 
metric system has been employed in all the following processes. 

These are the steps to be followed in order to change the units: 

 
Figure 1: How to change units in FreeCAD 

https://www.freecadweb.org/
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Click on Edit > Preferences 

Select General in the pop up window 

Go to Units and change the User System to “Standard” and confirm by pressing 
“OK”. 

 
 
1.3 Organising the views 

Start a new document by pressing CTRL+N. 

If the Combo View window on the left is already open, the following step can be 
skipped. 

The Combo View is opened by clicking on View > Panels > Combo View. 

This window is very useful for issuing commands quickly. It also contains the Tree 
and Property view which allows for a closer look at the structure of the project. 

 
 

1.4 Sketching a base 

To build a three-dimensional object a base must be sketched first. 

Change the Workbox from Start to Part Design. This will enable the option Create 
Sketch under the Task slide in the combo view window. 

Click on Create Sketch. This will pop up a new window to choose the orientation 
to sketch on. 
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Figure 2: First change the Workbox to Part Design. Then click on Create Sketch. 

Choose the XY-Plane, uncheck reverse direction and zero the offset. In this 
window the cube on the right will show the selected plane. The Reverse 
Direction option will switch to the opposite plane. With the option Offset the 
height of the plane can be changed. Press OK to proceed. 

Under the Tasks bar new options pop up. Here, the Grids properties can be 
changed. Check all the grid options and set the Grid size to10mm. 
Unchecking Show grid will hide the grid and Grid size will vary the spacing of the 
grid. Selecting Grid Snap will automatically snap a point to the closest crossing. 

Select the sketch tool Create a Rectangle. When the cursor moves over the 
coordinate system the current coordinates will be shown right next to the cursor. 
Click in the IV section of the coordinate system on the point -40.0, 40.0. Notice 



5 
 

how the points snap to the grid which lets you work with more precision. Create a 
rectangle 80.0 x 80.0 big. FreeCAD automatically sets constrains to the sketch as 
can be seen in the Constrains window on the left. Click on Close to exit the Sketch. 
The sketch can now be extruded to a three dimensional object.  

 

Figure 3: Set Grid options and select draw rectangle 
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1.5 Setting new points 

Select the Pad command under the Task section in the Combo View. 

Set the length to 60mm, the tab to Dimension and uncheck Symmetric to 
plane and Rewind. Length will determine how far the object is extruded. The 
option Rewind will extrude the sketch in the other direction. The second length 
will be enabled by switching the Dimension tab to two dimensions and will 
extrude the object on two sides. Confirm by pressing OK. 

 
 
1.6 Moving objects 
 

 
Figure 4: Different points of view. 1 Isometric view, 2 Front view 

You can also move the object around and take a look at it from different sides. 

Holding the middle mouse button and moving your mouse will move the object. 

You can also select different angles of view. The different views can be found right 
in the middle of the FreeCAD toolbar. The axiometric view projects the object in a 
three dimensional way. You can also choose to look at one specific side. 

When you lose track of your object press on the magnifying glass on the left of the 
view toolbar. This will centre your entire project. 

 

2. How to Cut Objects 

To begin with Lesson 2 of this FreeCAD tutorial, open the last lessons project and 
switch your Workbox to Part Design. At first, we want to hollow out our box with 
the cut feature. 
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2.1 Basic Cut Feature 
 

 
Figure 5: Set the dimensions of the Pocket feature found in the combo view. 

Select the Top plane by switching to the Top view in the view menu and clicking on 
the visible face of your box. Now create a new sketch under Task in the Combo 
view window. 

Set your grid to 5mm and check Grid Snap. Now draw a rectangle starting at -35.0, 
35.0 and make it 70.0 x -70.0 big. It should offset 5mm from the edges of your box. 
Click to confirm the rectangle and close the sketch. 

Go on by clicking on the Pocket feature right under the Pad feature in the combo 
view. This feature will cut everything inside your recently drawn rectangle. You 
can change the direction and the limit to cut to in the Type selection. Set Type to 
Dimension and your length to 55.0mm so the floor is 5mm thick. Also rename the 
created pocket to “Hole” by pressing F2. When you switch to isometric view you 
can see the hole in the box. 

 

 

 

https://all3dp.com/wp-content/uploads/2015/02/Pocket-Feature.png
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2.2 Offset 
 

 
Figure 6: Set the Draft Plane on the top face of the box. 

To keep the future lid in place, you will have to create a rim around the top of the 
box. Switch to the isometric view and select the top plane of the box again. Do not 
select the floor or walls of your box! Change the grid size to 5mm and enable grid 
snap. Now create a rectangle aligned with the top edges of your box starting at -40, 
40.0., close the sketch when finished and rename the finished sketch to Rim 1. To 
access the Offset tool, switch your Workbox from Part Design to Draft. 
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Figure 7: Disable draft grid after you finished drafting. 

Redefine your working plane by clicking on Set Working Plane and then on the 
top plane of your box. A grid should become visible. To show or hide the grid go to 
Draft > Utilities > Toggle Grid. The height working plane will determine the 
drafting level. Drafting on different levels will allow you to extrude the drafts into 
one object. 

Select the sketch “Rim 1″ in the Model section and select under Task 
the Offset tool. Check Copy so “Rim 1″ remains after the offset. When using the 
offset tool it is very important to move and keep your curser in the modeling 
window. You will notice a rectangle following your curser. Now do not move your 
mouse, type -2.5 and press enter. This will offset your sketch by 2.5mm to the 
inside. Also rename “D Wire001″ to “Draft”. 

Disable your Draft grid as shown earlier and switch Workbox back to Part Design. 
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2.3 Advanced Cut 
 

 
Figure 8: Sketch a rectangle on top of the draft. 

Double click on “Rim 1″ sketch to edit it. Set your grid to 2.5mm and check grid 
snap. Now draw a second rectangle right on top of “Draft” starting at -37.5, 
37.5 and close the sketch. 

Now you can also delete “Draft” by clicking on it and pressing the delete button. 

Select “Rim 1″ again and cut it by using the Pocket feature. Set Type to Dimension 
and Length to 5mm. This will cut the space inside the rectangles. 
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3. Fillets & Pattern 

In lesson 3 of this FreeCAD tutorial, you are going to learn how to multiply a part 
and make corners round. To begin open the box you created in lesson 2. 

 
3.1 The Pattern Feature 
 

 
Figure 9: Create a circle on the bottom of your box. 

The Pattern feature distributes an object equally. So before you can pattern an 
object you need to create one. In this step you are going to add little nubs on the 
bottom of your box. Switch your view to bottom view and select the visible plane. 
You should see the bottom of your box. Now create a new sketch on this plane and 
set your grid size to 5mm, also check grid snap. Select Create a Circle and draw a 
circle in the upper right hand corner of your box at -30.0, 30.0 with a radius of 
5mm. Now close the sketch. 

 

 

https://all3dp.com/wp-content/uploads/2015/02/Circle.png
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Select the sketch drawn in 1. and extrude it with the pad feature. Set length 
to 5mm and uncheck Symmetric to Plane and Reverse. Press OK to finish and 
rename the Pad to “Nub” by pressing F2. 

 

 
Figure 10: First select the entity you want to multiply and then click on the circle 

pattern feature. This will arrange the circle equally. 

Now click on “Nub” again and select the Polar Pattern feature. Set Angle 
to 360.00, Occurrences to 4 and uncheck reverse direction. This tool creates a 
circle pattern of a part with a specific angle and occurrences. The angle determines 
the size of your pattern. For example, at 360° the objects will be arranged in a full 
circle, at 90° only inside a quarter of a circle. With reverse direction checked your 
pattern will go around clockwise. 

 

 

 

 

 

 

https://all3dp.com/wp-content/uploads/2015/02/Pattern-Feature.png


13 
 

3.2 The Fillet Feature 
 

 
Figure 11: Create a fillet from the circle pads with the radius of 2.4mm. 

Switch to bottom view and select all the Nubs. To select many parts hold down 
CTRL and click on different parts. To unselect a part just click on it again. 

Now select the Fillet Feature. The adjustable radius determines the size of your 
fillet. The radius must be smaller than the entity you create a fillet so set the radius 
to 4.9mm. What you get looks just like little nobs. Close the feature and rename 
the Fillet to “Nub1″. 

 
3.3 How to make corners round 
 

 
Figure 12: First create a rectangle on the existing rim. Cut it by 2.5mm and then 

select the outward rim of your box to create a fillet. 

https://all3dp.com/wp-content/uploads/2015/02/Fillet.png
https://all3dp.com/wp-content/uploads/2015/02/Select-Rim.png
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Switch to top view and create a new sketch on the rim you created in lesson 2. Now 
draw a rectangle on the right side starting at 35.0, 37.5 and make it 2.5 x -
75.0 big. Exit the sketch and proceed to the next step. 

Create a new pocket with the sketch from 1., set the length to 2.5mm and uncheck 
reversed. Also rename the pocket to “SmallRim”. 

Now click on the outward edge of SmallRim and click on the Fillet Feature. Set the 
radius to 2.4mm. 
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4. Sweep Feature & Placement Regulation 

In lesson 4 of this FreeCAD tutorial, you will learn how to create a sweep out of two 
sketches and copy it afterwards. To begin, open your Tutorial Box and switch your 
Workbox to Part Design. 

 
4.1 Create a Sweep 

Switch to your right side view, select the right side of your box and create a new 
sketch. Set grid size to 2.5mm and sketch a new rectangle at -35.0, 50.0. Make this 
rectangle 10.0 x -2.5 big. This rectangle will be the base for your sweep so rename 
it to “Hinge Base” by pressing F2. 

 

Figure 13: Create the semicircle following these steps. 

Now click next to the box into the void to create another new sketch on the XZ-
Plane. Zoom in on the right side of your box and set grid size to 2.5mm as well. 

https://all3dp.com/wp-content/uploads/2016/10/Draw-circle.jpg
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Select the sketch tool ‘Ends Point and Rim Point’ circle. You can find it in the sketch 
section under the semicircles. Sketch a new circle at 40.0, 47.5 (1). Make the 
diameter of your circle 4.0R(2) big so the end point aligns with the top edge of 
your box. To complete the circle set it to 180° (3). This circle will guide your 
sweep, so rename it to “Hinge Guide” 

 
Figure 14: Move the sketch along the Y and Z-Axis. 

When you switch back to right side view, you will notice that “Hinge Guide” does 
not align with “Hinge Base”. To move it right into the middle of your rectangle click 
on “Hinge Guide” and after that on the Data tab found at the combo view bottom. 
Click on Placement now and then on the […] box to adjust the positioning of your 
sketch. Change the values in the Translation box. Set the Y-Axis to-30mm and the 
Z-Axis to 1mm. When using Translation the programme will use the coordinates of 
your sketch as 0,0,0 reference. Using the Centre values will use the overall 
coordinate system as a reference. Rotation gives you the option to rotate your 
sketch along an axis. Press OK to proceed. 

 

 
Figure 15: Select the Sweep Feature in the Part section of your Workbox. 

Switch your Workbox to Part and click on ‘Utility to Sweep‘. This tool extrudes a 
sketch following a certain path. In the Combo View you can see all of your sketches. 
Select the sketch “Hinge Base” and move it to the Sweep box by clicking on the 
arrow facing to the right. 

https://all3dp.com/wp-content/uploads/2016/10/Placement.png
https://all3dp.com/wp-content/uploads/2016/10/Sweeptool.png
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Figure 16: Always follow this order when creating a sweep: Select the base > Click on 
Sweep Path and select the path > press Done and OK. 

Now press Sweep Path and in the Model Section select “Hinge Guide” and switch 
back to Task.   Confirm the sweep by pressing done first and then OK. Rename 
Sweep to “Hinge”. 

 

4.2 Copy the Sweep 

Right click on “Hinge”, click on copy and confirm by pressing Yes in the Object 
Dependencies window. You can also use the shortcut CTRL+C. 

Paste the object by either right clicking on “Hinge” again or pressing CTRL+V. 

Now the copied object is right on top of the original. To move it, click on the 
Placement options as shown in Step 1,3. Move the object along its Y-Axis by 60mm. 

Now you have finished the box – congratulations! In the next lesson, you will 
create the cover for it. 

https://all3dp.com/wp-content/uploads/2016/10/Sweep.png
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5. The Revolution Feature & How to Cut with 
Two Objects 

In lesson 5 of this FreeCAD tutorial, you will create the cover of your box. The 
cover will be curved and hollowed out with the Revolution feature. No, you are not 
going to overthrow any government but you will create a solid curved shape 
around a sketch. To begin open a new document and save it as “Box cover”. Then 
switch your Workbox to Part Design. 

 
5.1 The Revolution feature 

Create a new sketch on the XY-Plane, draw a rectangle starting at -40.00, 
40.00 and make it 80.00 x -80.00. Rename the sketch to “Base”. 

 

 
Figure 16: Draw a rectangle on one-half of your base. 

Now extrude the sketch to 5mm height and rename it to “Base” also. When 
finished, start a new sketch on top of the extruded box. Draw another rectangle 
starting at -40.00, 40.00 and make it 80.00 x -40.00big. Rename it to “Base of 
Revolution”. 

https://all3dp.com/wp-content/uploads/2015/03/Baseofrevolution.png
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Figure 17: Set Axis to Horizontal and Angle to 180° to create half of a revolution. 

To create a revolution, click on ‘Base of Revolution’ first and then on the Revolve a 
sketch feature. Set Axis to ‘Horizontal Sketch Axis’ and Angle to 180°. Uncheck 
Symmetric to Plane and Reversed. Symmetric to plane will distribute the feature 
on each side of the sketched plane equally. 

 

 
Figure 18: Draw a second rectangle with an offset of 2.5mm to the edges on one-half 

of your box. 
 
 
 

https://all3dp.com/wp-content/uploads/2015/03/revolution-1.png
https://all3dp.com/wp-content/uploads/2015/03/2ndbase.png
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Hide the Revolution you created. by clicking on it in the Model view and pressing 
spacebar. Now create a new Sketch on top of ‘Base’ extrude. Set your grid to 2.5mm 
and draw a rectangle at -37.50, 37.50 and make it 75.00 x -37.50big. Rename it to 
‘Base of the 2. Revolution’ and create a new Revolution feature. Rename it to “2. 
Revolution”. Set the Axis to horizontal and Angle to 180° also uncheck Symmetric 
to Plane and Reversed. 

 
5.2 Cut with two objects 
 

 
Figure 19: Subtract with the Boolean command one object from another one. 

Switch your Workbox to Part and select Run a Boolean operation. Check Difference 
in the Boolean operation window. This will subtract the Second Shape from the 
First Shape. Union will combine two objects, intersection will extract the common 
part of two objects and section will extract the common part of two objects as a 
non-solid. 

Check as First Shape ‘Revolution’ and as Second Shape ‘2.Revolution’. Click on 
Apply to confirm the subtraction. 

To finish we create a new sketch at the bottom of ‘Base Extrude’. Draw a rectangle 
starting at -37.50, 37.50 and make it 75.50 x -75.50 big. Cut the sketch with the 
Cut feature by a length of 5mm. 

 

 

https://all3dp.com/wp-content/uploads/2015/03/Substraction.png
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1. 3D Printing: Printing our vehicle 

 

Before a 3D model output can be implemented on a 3D printer, the model has to be 
converted into a format that the printer can manage. This process is called slicing 
as the model is divided into small layers – the slices. 
 
A special software is needed to do the slicing. The software which as been used for 
3D printing in this project is Cura. Cura software allows the user to import an STL 
(or OBJ) file and prepare it for any printer model (each model has its specific 
settings). 
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This software package prepares the 3D model into instructions that the specific 3D 
printer requires to produce an object. Cura is an open source software developed 
by Ultimaker to make 3D printing as easy and streamlined as possible.  

It contains everything that is needed to prepare a 3D file for printing. It is fully 
preconfigured to work with the BQ Witbox 1 which was available for this project.  

Cura has an integrated setup programme that guides the user on the installation of 
the latest firmware as well as to calibrate the printer.  
 
While the user is making decisions on the look and quality of the 3D object, the 
slicer engine included in Cura prepares the model in the background. 
 
With Cura it is only possible to copy your print file to an SD card and print from it.  
 

With Cura software, the user sets a number of settings that depend on the printer, 
model and the print material used. The most important settings are layer height 
and layer thickness.  
 
Then Cura 3D calculates the outline of the model layer by layer and determines the 
path the print head has to take in order to print the object. 
 
The Cura software not only slices the model: It creates the commands that the 
printer interprets and executes while printing.  
 
This code is called the G-code. When Cura 3D is finished, the user will save this 
code to a file on an SD card that can be fed later into the printer. 
 

2. The Basics 

 
 
2.1 Installing the Cura software 
 
The first step will be to select the printer model that a G-code will be created for. 
 

To do this, the installation file for your operating system must be obtained from 
the Ultimaker website and you must install the latest version of the software.  
 
Launch Cura 3D. 
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Select the printer model. BQ Witbox 1 is the one being used in this project. 
 
 
2.2 Quick overview 
 

This screenshot shows the basic features: 

 
Figure 1: The Cura 3D interface. 

 
Open file: This option or the File > Open command can be used to open the STL or 
OBJ file. 
 
View Mode: This option allows switching between Layers and Solid view. 
 
Printer: This option allows the user to open the printer-specific settings. 
 
Setup: In Simple mode only very basic settings can be changed, in Advanced 
mode the user will have access to all printer settings.  
 
Save to File: The Gre-code can be saved into the hard disk or directly to an SD card 
in order to be used by the printer. 
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2.3 Handling your model in Cura 3D 
 
A basic stand for a tablet has been used for this project. To load the 3D model, use 
Open file as explained earlier. 
  
There are two views available; Solid view and Layer view. In Solid view, the 
entire object can be seen as it will look when printed.  
 
In Layer view, there is a scrollbar to the right through which an individual layer 
can be selected; alternatively, the user can go through layer by layer using 
the Up/Down arrow keys on their keyboard. 
 
When switching to Layer view, it may take a while before the layers are calculated 
and displayed (depending on the model and computer hardware). 
 

 
Figure 2: Display the model in Layer or in Solid view. 
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After loading the model, the user can scale, rotate or mirror it on the build platform 
using the three buttons to the left.  
 
The user should switch to Solid view before rotating the model as it takes a while 
to recalculate the layers in Layer view so rotating might be quite sluggish. 
 
When the model is selected, a green and a red arrow will appear. Using these 
arrows, the user can move the model to the front/back and left/right on the 
workspace. 
 
In order to get a more detailed view, user can click the Scale button and enter a 
higher percent value – always maintaining the Uniform Scaling setting, otherwise 
the printed model will be distorted. In order to close the Scale dialogue box, the 
user can click the Scale button a second time. 
 
The user can right click the object to undo any changes. This will open the context 
menu where the user can undo all changes and centre it on the platform.  
 
The model can also be duplicated with this menu. 
 
2.4 Cura 3D settings 
When Cura is started, Simple mode is activated. Here, there are only two settings 
available in Cura 3D. The user may select print quality and may have support 
structures printed together with the model: 
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Figure 3: Setup modes 

 
In Simple mode, select print quality and decide whether to add supports or not. 
 

If needed, the Enable Support option can be checked (in this project, no supports 
are needed). Most 3D models require support structures, so it is best to 
have Enable Support checked. 
 
Supports are needed when the model has overhanging parts or parts floating in the 
air. 
 
To set the print quality, chose Advanced and they change to the quality desired. 
Cura software displays the print duration for minimum and maximum print 
quality.  
 
The field to the left of the Save to Disk button displays estimated print time and 
material required for the currently selected quality. 
 
For a quick print of a draft, Low Quality can be chosen. If you need maximum 
quality and time is not as important as quality, choose Maximum Quality.  
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Figure 4: High Quality 

 
Cura 3D now calculates layer height, print speed and other settings according to 
the quality selected. 
 
Cura 3D remembers these two settings and defaults for later projects. 
 
 
2.5 Generate a G-code file 

 

The last step is to save the model in a printable G-code file. 
 

The Save to Disk option or select File > Save can be used. 
 

Enter a file name and the folder where the file is stored. The file may be stored on 
the SD card used to transfer the file to your 3D printer; but usually it is first stored 
on the hard disk and then copied to the SD card. 
 
Select GCode File (*.gcode) as the type of file and click Save. 
 



8 
 

Copy the file on an SD card and insert the card into the 3D printer’s SD slot. 
 
 

3. Cura Software Settings 

 

While the basic print settings of the Cura software are fine to start with, 
the Advanced settings give more control over the output. Basically, there are two 
ways to access the Advanced settings: 

1. Through the tabs in the Print Setup pane on the right-hand side of the Cura 
window, 

2. Through the Preferences > Settings menu.  

 
Figure 5: Advanced Setup 
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3. The Print Setup pane contains the most relevant settings, while in 
the Preferences > Settings menu the user has access to all the print 
settings – and the user can select selected which of these settings are 
displayed on the Print Setup pane. 

We will start with the Print Setup pane. 

 
 

3.1 Quality settings 
 

In the Mode field, select Advanced instead of Simple. Below Print Setup, a 
number of tabs for Quality, Material and other settings are displayed. 
 
Click Quality to define the surface quality of the 3D printed object. 
 

 
 

Figure 6: Cura Quality settings 
 
 

Layer Height is by default 0.1 mm. If the selected printer supports thinner layers, 
the height can be decreased to get smoother surfaces, however, that will increase 
print time. 
 
The Shell > Wall Thickness setting of Cura 3D determines the thickness of the 
walls of the object. It has to be an integer multiple (1x, 2x, 3x, etc.) of the nozzle 
diameter. A thickness setting of 0.8 mm means that walls will be 2 lines wide (as 
the nozzle of our Ultimaker 2 printer has a diameter of 0.4 mm). 
 
The Bottom/Top Pattern can be either Lines or Concentric. 
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The Bottom/Top Thickness is usually also set to 0.8 mm. If an object with a large 
flat top is printed, user may want to print more layers in order to close the top 
surface completely. This avoids the unwanted “pillowing” effect.  
 
As the Bottom/Top Thickness setting is not by default in the Print Setup pane, 
the user first has to open Preferences > Settings and check Bottom/Top 
Thickness – now the setting will be displayed in the Print Setup, so the user can 
increase the value (again in integer multiples of the nozzle diameter). 
 
 
3.2 Material settings 
 

Usually, there is only the Retraction option in the Material section. It is 
recommended that users leave Retraction turned on. Retraction means that the 
filament will be retracted, i.e., pulled back, when the printer nozzles move over an 
area that is not printed. This way, no filament will come out of the nozzle. There 
will be no “stringing” – no thin threads of plastic between the printed parts of the 
object. 
 
If the user wishes to change other material settings, the Preferences > 
Settings will present all the settings that might need changing.  
 
The recommend temperature settings for PLA are a Printing 
Temperature of 210 Infill Thickness C and a Bed Temperature of 60°C; for ABS 
the Printing Temperature must be set to 250°C and the Bed 
Temperature to 90°C. 
 
Usually, there is no need to change the default Diameter and Flow values. If user 
needs to do so, the settings can be enable under Preferences > Settings. 
 
Flow is the entire amount of material that needs to be extruded for the object. 
The Flow value is usually set to 100%, so the extruded amount equals the amount 
of material required. The user will only need to increase this setting if they use 
very soft materials. 
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3.3 Speed settings 
 
If the user wishes to print faster than the default (and recommended) 50 mm/s, 
the Print Speed value may be increased. In this case, it is recommended that 
the Print Temperature value is also increased so that the plastic is properly 
melted. 
 
The Travel Speed setting determines how fast the print head moves when it is not 
printing (e.g., when moving from one wall to the next). The default 150 mm/s is 
appropriate for most cases. 
 
In the Preferences > Settings dialogue, there are other speed settings that allow 
control over the speed for specific parts of the print. In case the user wishes to 
change any of these speed settings, Print Speed is the setting to change; this will 
make accelerating and decelerating smoother when changing e.g. from infill to 
shell printing. 
 
 
3.4 Infill settings 
 

Infill Density determines how much plastic is printed inside the object. A higher 
value means that more plastic will be printed – which will result in a stronger 
object. Typically, 10% to 20% are sufficient to build strong objects. In case user 
wishes to print the object completely hollow, the density must be set to 0%. 
 
If the user wishes to change other infill settings, these must first be selected in 
the Preferences > Settings dialogue to make them accessible on the Print 
Setup panel. The Infill Thickness and Infill Layers settings allow the user to 
reduce print time when the quality of the infill is less important: sparse infill is 
printed in fewer layers to save print time. Infill Thickness sets the thickness of the 
sparse infill; the value has to be a multiple of the layer height. Infill Layers allows 
to combine several layers to form sparse infill. 
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3.5 Cooling 
 

Turning off the Enable Cooling Fan setting is not recommended as it will result in 
warping and other ugly surface effects. 
 
In order to control the cooling fan more precisely with the Cura software, the user 
must enable the Cooling settings in the Preferences > Settings dialogue, e.g. 
the Fan Speed settings in order to increase Maximum Fan Speed when it is very 
hot in the office or to decrease it when the fan is too loud. 
When the user wants to make sure a layer has enough time to cool before the next 
layer is printed above it, set the Minimal Layer Time. Increasing this value also 
increases print time. 
 
Through the Minimum Speed setting the user can make sure the printer does not 
slow down too much as that means that the nozzle will be on the same spot for a 
longer time – keeping the plastic at that spot hot. A Minimum Speed below 100 
mm/s will reduce print quality. 
 
When an object with a small top is printed, it is recommended to use the Lift Head 
option. This removes the print head from the object so it can cool down (otherwise, 
you might end up with a blob at the top of the object). 
 
 
3.6 Support settings 
Do not turn the Enable Support option off – otherwise floating or overhanging 
parts cannot be printed. 
 

 
Figure 7: Cura 3D: Support settings 

 
The Placement option determines where supports are attached: Touching Build 
plate means the supports are based only on the build plate; Everywhere means 
the support structures can also be built on the model or inside the model. 
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The Overhang Angle value determines how much overhang a part has to be 
supported; the default is 60°. Note that setting the Overhang Angle to 90° will 
create no support structures at all. 
 
There is also the Use towers setting. These “towers” are special support structures 
that have a larger diameter than the supported parts and that are smaller at the 
top. This way, these supports can be removed more easily and there will be less 
traces of the supports on the printed object. 
 
3.7 Platform Adhesion settings 
 

In order to improve bed adhesion or in case the object does not have a flat bottom, 
a brim or a raft can be added. If the user does not do this, Cura software 
automatically adds a skirt around the object.  
 

 
Figure 8: Cura 3D: skirt settings 

 
The skirt is a line around the print on the first layer that helps prime the extruder. 
A brim is made of a few lines attached directly to the bottom of the object; this 
increases the bottom surface and minimises warping. A raft is a thick grid 
underneath the model and helps the object stick to the build plate. 
 
In case the user simply wants the skirt printed, the user must 
set Type to None and select the number of skirt lines and the distance to the 
object. 
 
In case the user wants a brim printed, the user must select Type: Brim and set 
the Brim Line Count, i.e., the number of lines to be printed. 
 
To have a raft printed, user must select Type: Raft and adjust the margin, the 
thickness and other settings. 
 



1 
 

 

CONCLUSIONS 

  

This project is focused on the study of an implementation of both Raspberry and 
Gertbot for the operation of electrical drives, as a practical example of the several 
applications that can be achieved with both Raspberry and the Gertbot. 

As has been outlined on each of the documents that make up this study, it is 
possible to operate a remote-controlled car in a simple and intuitive way, using a 
Python script and the combination of a Raspberry PI and a Gertbot. 

This project aims to help the students of the subject Electrical Drives in the 
development of the practical side of the subject, serving as a guide or manual for 
them and providing them with the different references through which they can 
expand their knowledge on all aspects of the practical side of the subject. 

Therefore, several different competitions can be held with the designed vehicle, 
changing the rules of said competitions and achieving higher levels of complexity, 
enabling different trajectories and speeds that the vehicle will be able to attain. 

The tools employed in this project, such as Gertbot, not only permitted this design, 
but also made possible all kinds of designs of all levels of complexity; from a 
personal web server or a home automation system. 

On a personal level, this study has allowed me to gain a better understanding of the 
Raspberry PI and start to familiarise myself with Python, consolidating some 
concepts I acquired during my degree, this leading to a practical use of the same. 
This has been a perfect finishing experience; to be able to design and create 
something and make it work as an engineer. 
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